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Over v iew 
ImageNow contains a feature called Tasks. This guide is designed to provide you with step-by-step 
instructions on how to define and use tasks in your system. How you use tasks will depend on your role, 
which ranges from administrative (task template manager) to processing (task assignees). This guide 
contains the following sections: 

• What are tasks? introduces tasks and the task specific roles available in ImageNow. 

• Task reasons and reason lists explains action and return reasons and reason lists. This section is 
written for task template managers. 

• Create task templates explains how to create task templates, which define the behavior of the 
tasks. This section is written for task template managers. 

• Create tasks explains how to create tasks based on the available task templates. This section is 
written for task creators. 

• Process tasks contains procedural topics including how to complete, sign, and return tasks. This 
section is written for task assignees. 

• Process Complete Pending Review tasks explains how to locate and complete tasks that require 
review. This section is written for task reviewers. 

• Reference contains information about toolbars and security privileges for task actions. 

More specialized topics on working with tasks are available from the Product Help, available in 
ImageNow and WebNow. 

What  are  tasks?  
A task is work on documents and folders that you assign to one or more users. There are three task 
types: document deficiency, pointer, and signature required. You choose the task that best matches the 
work that needs to be done. The task types are defined as follows: 

• Document deficiency - Create this task type to indicate when a document is missing or incomplete. 

• Pointer - Use this task type to draw attention to a specific document or folder location for further 
action. 

• Signature required - Assign this task type when a user needs to digitally sign a document. You 
must have the Document Management Suite license installed on your ImageNow system for this 
task type to be available. 

To create a task, you must first create and configure a task template. As a task template manager, you 
set the properties, components, actions, assignment, reasons, due date, and security options for the 
template. Task template security allows you to determine the roles your users have when working with 
tasks. 

Task levels and ser ies h ierarchies 
When you create a task in ImageNow and WebNow, you can use task levels to assign a series of tasks. 
Each level in the series represents a single task and is sequential. A task series starts with Level 1 and 
contains at least two levels. When the task for Level 1 is complete, a new task is created for the task 
assignee on Level 2. You can assign up to ten task levels, and, in turn, you can assign multiple users or 
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a single group to each level. You can assign the same users or group to multiple levels, however, only 
the users and groups assigned to the task template are available for assignment. 

If you need to accelerate the task completion process, you can set up a task series as a hierarchy. As 
with task levels, the task series represents a single task that starts with Level 1 and contains at least two 
levels. However, with the hierarchy, an assignee at a higher level becomes an optional assignee for all 
prior levels and can complete the task at any time. When an optional task assignee completes a task, 
that assignee’s level in the hierarchy determines whether the next task in the series is created or if the 
series is complete. When you create a task series hierarchy, you can assign levels to users only and 
each level must contain unique users.  

Task ro les 
The primary ImageNow task roles are task template manager, task creator, task assignee, and task 
reviewer. A task template manager configures a task template. A task creator creates and assigns tasks 
to task assignees. These assignees, in turn, sign, complete, or return tasks. You can assign tasks to 
multiple users or to a single group. After a task assignee completes a task, a task reviewer may be 
required to review the task. A review is required when the completion method is set to "Complete 
pending review" in the task template. 

Grant  task template manager pr iv i leges 
You can complete this procedure only if you are a user with management privileges, a manager, or the 
owner. 

This privilege is necessary to create and manage task templates. You manage only the task templates 
you create. To manage another user's template, you must have the Manage privilege for that template. 

1. In the Management Console, in the left pane, perform one of the following options: 

• To grant a privilege to a user, click Users and then in the right pane, on the Security tab, 
perform one of the following actions: 

• In the Select a user list, select a user, and then click Modify. 

• In the Search for users box, type all or some of a user name, first or last name, and then 
click Search. In the Select a user list, select a user, and then click Modify. 

Note  To sort the Select a user list in ascending or descending order, click the Name, Last 
Name, First Name, or Status column headers. 

• To grant a privilege to a group, click Groups and then in the right pane, on the Security tab, 
perform one of the following actions: 

• On the Groups tab, in the Select a group list, select a group and then click Modify. 

• On the Groups tab, in the Search for groups box, type all or part of a group name and then 
click Search. In the Select a group list, select a group and then click Modify. 

Note  To sort the Select a group list in ascending or descending order, click the Name 
column header. 

2. In the Security Settings dialog box, click the Global Privileges pane. 

3. In the Privileges list, under Manage, select the Task Templates privilege. 

4. Click the column to the left of the privilege so that    displays to grant the privilege. 

5. Click OK until you return to the Management Console. 
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Grant  task creator pr iv i leges 
A task creator uses a task template to create tasks. To create a task, you must be a user with the Create 
privilege for a task template, a manager, or the owner. A user with this privilege can only modify the 
tasks they create with this template.   

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, on the Templates tab, perform the following substeps: 

1. In the Select a task type list, select a task type. 

2. Under Templates, in the Select a template list, select a task template and then click Modify. 

3. In the Task dialog box, in the left pane, click Security. 

4. In the right pane, under Users and Groups, click Add. 

5. In the Select Users and Groups dialog box, to add users or groups so they can create tasks with 
this template, perform one of the following actions: 

• To grant a privilege to a user: 

• On the Users tab, in the Search results list, select one or more users, click Add and then 
click OK. 

• On the Users tab, in the Search for users box, type all or part of a first name, last name, or 
user name of the user you want and then click Search. In the Search results list, select one 
or more users, click Add, and then click OK. 

• To grant a privilege to a group: 

• On the Groups tab, in the Search results list, select one or more groups, click Add, and 
then click OK. 

• On the Groups tab, in the Search for groups box, type all or part of the group name you 
want and then click Search. In the Search results list, select one or more groups, click Add, 
and then click OK. 

6. In the Task dialog box, under Users and Groups in the Name list, select the user or group to whom 
you want to grant the Create privilege. 

7. Under Privileges, in the Privilege list, click the column in front of the Create privilege so that   
displays to grant the privilege. 

8. Optional. Verify that the Automatically grant task creators the Review privileges for the tasks 
they create check box is selected. Clear this option if you do not want task creators to review tasks 
they create. 

Ver ify  task assignee v iew pr iv i leges 
A task assignee can complete, sign, or return a task to the task creator. To perform one of these actions, 
a task assignee must be able to access the Tasks pane in ImageNow Viewer. By default, the All Users 
group has the Access, Access by URL, and Filter privilege for all task views. 

1. In the Management Console, in the left pane, click Views. 

2. In the right pane, click the Task tab.  

3. Under Select a view, to verify the privileges for a view, select that view and then click Modify. 
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4. In ImageNow View Designer, on the File menu, click Properties. 

5. In the View Properties dialog box, on the Security tab, under Users and Groups, click All Users. 

Under Privileges, verify that  appears in front of the Access, Access by URL, and Filter privileges.  

6. Click OK. 

Grant  task rev iewer pr iv i leges 
A task reviewer reviews a task after a task assignee completes or signs a task. A task reviewer is 
required only when the completion method is set to “Complete pending review” in the task template.  

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, on the Templates tab, perform the following substeps: 

1. In the Select a task type list, select a task type. 

2. Under Templates, in the Select a template list, select a task template and then click Modify. 

3. In the Task dialog box, in the left pane, click Security. 

4. In the right pane, under Users and Groups, click Add. 

5. In the Select Users and Groups dialog box, to add users or groups so they can create tasks with 
this template, perform one of the following actions: 

• To grant a privilege to a user: 

• On the Users tab, in the Search results list, select one or more users, click Add, and then 
click OK. 

• On the Users tab, in the Search for users box, type all or part of a first name, last name, or 
user name of the user you want and then click Search. In the Search results list, select one 
or more users, click Add, and then click OK. 

• To grant a privilege to a group: 

• On the Groups tab, in the Search results list, select one or more groups, click Add, and 
then click OK. 

• On the Groups tab, in the Search for groups box, type all or part of the group name you 
want and then click Search. In the Search results list, select one or more groups, click Add, 
and then click OK. 

6. In the Task dialog box, under Users and Groups in the Name list, select the user or group to whom 
you want to grant the Review privilege. 

7. Under Privileges, in the Privilege list, click the column in front of the Review privilege so that   
displays to grant the privilege. 

8. Click OK until you return to the Management Console. 
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Grant  Manage Returned pr iv i leges 
A user with the Manage Returned privilege can view and modify any returned task created with the task 
template. Granting this privilege allows a user to manage those tasks originally created using an iScript.  

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, on the Templates tab, perform the following substeps: 

1. In the Select a task type list, select a task type. 

2. Under Templates, in the Select a template list, select a task template and then click Modify. 

3. In the Task dialog box, in the left pane, click Security. 

4. In the right pane, under Users and Groups, click Add. 

5. In the Select Users and Groups dialog box, to add users or groups so they can manage returned 
tasks for this template, perform one of the following actions: 

• To grant a privilege to a user: 

• On the Users tab, in the Search results list, select one or more users, click Add, and then 
click OK. 

• On the Users tab, in the Search for users box, type all or part of a first name, last name, or 
user name of the user you want and then click Search. In the Search results list, select one 
or more users, click Add, and then click OK. 

• To grant a privilege to a group: 

• On the Groups tab, in the Search results list, select one or more groups, click Add, and 
then click OK. 

• On the Groups tab, in the Search for groups box, type all or part of the group name you 
want and then click Search. In the Search results list, select one or more groups, click Add, 
and then click OK. 

6. In the Task dialog box, under Users and Groups in the Name list, select the user or group to whom 
you want to grant the Manage Returned privilege. 

7. Under Privileges, in the Privilege list, click the column in front of the Manage Returned privilege so 

that   displays to grant the privilege. 

8. Click OK until you return to the Management Console. 
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Task  reasons and reason l i s ts  
Reasons provide users with pre-set descriptions that they can select to indicate why they are signing, 
completing, or returning a task. Task assignees are prompted to select reasons from two drop-down 
reason lists: Action and Return. Before you can configure a task template, you must create at least one 
reason and one reason list.  

About reason l ists and tasks 
A reason list is a set of reasons that you, the administrator, bundle as a list from which the user can 
select. For example, as administrator, you control the contents of every reason list as well as which 
reason lists are available for each of the three task template types. You can: 

• Create, modify, and delete reasons. Action reasons and reason lists for signature required task 
templates are managed in the Digital Signatures area of the Management Console. For a user to 
access Digital Signature reasons and reason lists, he or she must have the Manage Digital 
Signatures privilege. When you create action reasons and reason lists for document deficiency and 
pointer task templates, you do so in the Tasks area of the Management Console. Additionally, return 
reasons for each of the task template types are managed in the Tasks area of the Management 
Console. A user must have the Manage Task Templates privilege to access Tasks in the 
Management Console.  

• Add reasons or remove reasons from reason lists, as well as arrange the reasons in a preferred 
selection order. Typically, you place the most frequently cited reason at the top of the list. This 
allows a task assignee to simply press ENTER to select a reason rather than requiring the assignee 
to scroll the reason list. 

• Create and remove reason lists.  

• Assign action reasons to signature required task templates. Action reasons are optional for 
document deficiency and pointer task templates, but they are mandatory for signature required task 
templates. 

• Assign return reasons to all task types. Return reasons are required for each task template type. 

Manage reasons for a task template 
To perform this procedure, you must be a user with the Manage Task Templates privilege, a manager, or 
the owner. 

You create action and return reasons and then group them together in reason lists. Refer to the "Manage 
a reason list for a task template" section for more information about reason lists. The reasons and 
reason lists you create in the Tasks area of the Management Console can be assigned as action and 
return reasons for document deficiency and pointer task templates. Signature required task templates 
also utilize these same reasons and reason lists as return reasons, however, action reasons and reason 
lists for signature required task templates are managed in the Digital Signatures area of the Management 
Console. For more information regarding managing reasons for signature required task templates, refer 
to the "Manage action reasons for a signature required task template" section. 

1. In the Management Console, in the left pane, click Tasks. 
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2. In the right pane, click the Reasons tab and then perform one or more of the following actions: 

• Create a reason 

1. Click New. 

2. In the Reason text box, type a name. 

• Modify a reason 

3. Select a reason and then click Modify. 

4. In the Reason text box, type a new name. 

• Delete a reason 

1. Select a reason and then click Delete. 

2. In the Delete Reason confirmation box, click Yes. 

3. Press Enter. 

Manage a reason l is t  for a task template 
To perform this procedure, you must be a user with the Manage Task Templates privilege, a manager, or 
the owner. For more information regarding task privileges, refer to  the "Task privilege definitions" table. 

Reason lists are used when you define action and return reasons in document deficiency and pointer 
task templates. Signature required tasks differ from the other task templates because you define action 
reasons in the Digital Signatures area of the Management Console. Refer to the "Manage action reason 
lists for a signature required task template" section for more information. 

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, click the Reason Lists tab and then perform one or more of the following actions: 

1. Create a reason list 

1. Click New. 

2. In the Reason List dialog box, on the General tab, perform the following steps: 

1. In the Name box, type a name for your reason list. 

2. In the Description box, type a reason list description. 

3. Verify that the Is active check box is selected to make the list available for assignment. 

3. On the List Members tab, in the Available list, press CTRL, select one or more reasons and 
then click Add. 

4. Optional. In the Selected list, rearrange the reason order as necessary: 

• To change the position of a reason in the list, select a reason and then click Move Up or 
Move Down. 

• To remove a reason from the list, select a reason and then click Remove. 

5. Click OK. 

2. Modify a reason list 

1. Select a list and then click Modify. 
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2. In the Reason List dialog box, on the General tab, perform the following steps: 

1. In the Name box, type a new name. 

2. In the Description box, type another description. 

3. Clear or select the Is active check box. 

3. On the List Members tab, perform one or all of the following steps: 

1. In the Available list, select the reasons you want and then click Add. 

2. Optional. In the Selected list, select a reason and then click Move Up or Move down to 
change the order reasons appear in the list. 

3. Optional. In the Selected list, select a reason and then click Remove to remove the 
reason from the list. 

4. Click OK. 

3. Delete a reason list 

1. Select a reason list and then click Delete. 

2. In the Delete Reason List confirmation box, click Yes. 

Note  If the reason list you want to delete is currently associated with a task template, the 
list is made inactive. 

Manage act ion reasons for a s ignature required task template 
To perform this procedure, you must be a user with the Manage Digital Signatures privilege, a manager, 
or the owner. For more information regarding task privileges, refer to the "Task privilege definitions" 
table.  

1. In the Management Console, in the left pane, click Digital Signatures. 

2. In the right pane, click the Reasons tab and then perform one or more of the following actions: 

• Create a reason 

1. Click New. 

2. In the Reason text box, type a name. 

• Modify a reason 

1. Select a reason and then click Modify. 

2. In the Reason text box, type a new name. 

• Delete a reason 

1. Select a reason and then click Delete. 

2. In the Delete Reason confirmation box, click Yes. 
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Manage act ion reason l ists for s ignature required task templates 
To perform this procedure, you must be a user with the Manage Digital Signatures privilege, a manager, 
or the owner. For more information regarding task privileges, refer to the "Task privilege definitions" 
table. 

You create action reason lists for signature required task templates or modify existing system reason 
lists in the Reason Lists area of Digital Signatures. 

1. In the Management Console, in the left pane, click Digital Signatures. 

2. In the right pane, click the Reason Lists tab and then perform one or more of the following actions: 

• Create a reason list 

1. Click New. 

2. In the Reason List dialog box, on the General tab, perform the following steps: 

1. In the Name box, type a name for your reason list. 

2. In the Description box, type a reason list description. 

3. Verify that the Is active check box is selected to make the list available for assignment. 

3. On the List Members tab, in the Available list, press CTRL, select the reasons you want 
and then click Add. 

4. Optional. In the Selected list, rearrange the reason order as necessary: 

• To change the position of a reason in the list, select a reason and then click Move Up or 
Move Down. 

• To remove a reason from the list, select a reason and then click Remove. 

5. Click OK. 

• Modify a reason list 

1. Select a list and then click Modify. 

2. In the Reason List dialog box, on the General tab, perform the following steps: 

1. In the Name box, type a new name. 

2. In the Description box, type another description. 

3. Clear or select the Is active check box. 

3. On the List Members tab, perform one or all of the following steps: 

1. In the Available list, select the reasons you want and then click Add. 

2. Optional. In the Selected list, select a reason and then click Move Up or Move down to 
change the order reasons appear in the list. 

3. Optional. In the Selected list, select a reason and then click Remove to remove the 
reason from the list. 

4. Click OK. 
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• Delete a reason list 

1. Select a reason list, and then click Delete. 

2. In the Delete Reason List confirmation box, click Yes. 

Note  If the reason list you want to delete is currently associated with a task template, the 
list is made inactive. 

Crea te  task  templa tes 
After you configure your action and return reasons and reason lists, you can create a task template. As a 
task template manager, you specify the task type, a location (folder, document, and page), iScripts, an 
assignment list, a completion method (automatic with valid digital signature, manual and complete 
pending review), reasons (action and return), a due date method, and security options. Task template 
security allows you to determine the roles your users have when working with tasks. The following figure 
shows you the task template dialog box. The title of the dialog box is relative to the task type you select: 

• Document deficiency 

• Pointer 

• Signature required on document 
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Create a s ignature required task template 
Create this task template type to indicate when a document requires a digital signature. You must have 
the Document Management Suite license installed on your ImageNow system for this task type to be 
available. 

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, on the Templates tab, in the Select a task type box, click Signature required on 
document. 

3. Under Templates, click New. 

4. In the Signature Required on Document Task dialog box, perform the following substeps: 

1. Define the signature required task template properties. 

1. In the left pane, verify that Properties is selected. 

2. In the right pane, under General, in the Name box, type a name for your task template. 

3. In the Description box, type a template description. 

4. Under Options, verify that the Is active check box is selected. This makes the task template 
available to task creators who are assigning tasks from the Tasks toolbar. 

5. Optional. Select the Delete completed task check box to automatically and permanently 
delete a task and its related history after the task is completed.   
 
Note  If a task creator assigns a task series and the Delete completed task check box is 
selected, ImageNow does not delete the tasks in that series until the series is complete. 
After a series is complete, that entire series is removed. For more information about task 
series, refer to the “Task levels and series hierarchies” topic. 

2. Define the signature required task template components. 

1. In the left pane, click Components. 

2. In the right pane, under General, in the Task instructions box, type the instructions you 
want your task assignees to see. 

3. Optional. Select the Modifiable during task creation check box to allow a task creator to 
modify the instructions in the New Task dialog box. 

4. In the Task location section, clear or select the Page with a visual representation check 
box. If Page with a visual representation is selected, a visual representation appears on 
the document.  

Note  Document is the default location and cannot be modified. Folders cannot be signed, 
but they can contain signed documents. 

5. In the Completion method box, Automatic with valid digital signature is selected and 
cannot be changed. 
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6. Optional. Under Workflow Assignment, select one or both of the following workflow 
options: 

• Send to queue -  Select the destination queue option you want. The default option is 
(None), in which case documents or folders are not sent to any queue. If you want to 
allow the task creator to choose a workflow queue to which they have add privileges, 
select (Prompt). All other options are the queues to which the current user has the Add 
privilege.  

• Send the folder to the workflow queue if the task location is a document in a folder 
– If the task location is a document in a folder, select this option to send the folder to 
workflow. 

Note  To enable the option of sending the folder to the workflow queue if the task 
location is a document in a folder option, in the Send to queue box, select a queue or 
Prompt. 

3. Optional. Define a signature required task template action. 

1. In the left pane, click Actions. 

2. In the right pane, under Scripting, perform one or more of the following actions to apply an 
iScript to: 

• Assigned tasks, in the Assigned list, select a script. 

• Returned tasks, in the Returned list, select a script. 

• Pending review tasks, in the Pending review list, select a script. 

• Complete tasks, in the Complete list, select a script. 

• Canceled tasks, in the Canceled list, select a script. 

• Invalid tasks, in the Invalid list, select a script. 

3. To send an email notification to task assignees when a task is created with this template, 
under Notifications, select the Send email notification when task is created check box. 
 
Note  A task assignee must have an email address configured in his or her user profile in 
order to receive an email notification. For more information, refer to the “Configure task 
email notifications” topic. 

4. To include a link in the email notification, perform one or both of the following actions: 

• To include an ImageNow link, select the Include ImageNow link check box. 

• To include a WebNow URL link, select the Include WebNow URL link check box. 

4. Define the signature required task template assignment list. 

1. In the left pane, click Assignment. 

2. In the right pane, click Add. 
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3. In the Select Users and Groups dialog box, to add users or groups so they are available for 
task assignment, perform one of the following actions: 

• To add users to your assignment list, on the Users tab, perform one of the following: 

• In the Search results list, select one or more users, click Add, and then click OK. 

• In the Search for users box, type all or part of a first name, last name, or user name 
of the user you want and then click Search. In the Search results list, select one or 
more users, click Add, and then click OK. 

• To add groups to your assignment list, on the Groups tab, perform one of the following 
actions: 

• In the Search results list, select one or more groups and then click Add.  

• In the Search for groups box, type all or part of the group name you want and then 
click Search. In the Search results list, select one or more groups, click Add, and 
then click OK. 

Notes 

• To sort the Search results list in ascending or descending order, click the User 
Name, Last Name, First Name, or Groups column headings.  

• The assignment list must contain at least one user or group. 

4. Optional. Select the Automatically assign the task to the task creator check box. 

5. Define the signature required task template reasons lists. 

1. In the left pane, click Reasons. 

2. Under Action Reasons, in the Action list, select the action list you want. The assignee must 
specify the reason why he or she is signing a document. The Assignee must specify a 
reason during task completion check box is unavailable and appears dimmed. 

3. Under Return Reasons, in the Return list, select a return list. 

Note  A return list is required. 

6. Define the signature required task template due date method. 

1. In the left pane, click Due Date. 

2. In the right pane, under Due Date Calculation, in the Method list, select one of the 
following methods: 

• No due date 

• In the Method list, click No due date. 

• Based on assignment date 

1. In the Method list, click Based on assignment date. 

2. In the Days box, set the number of days you want. 

• Based on start date 

1. In the Method list, click Based on start date. 

2. In the Days box, set the number of days you want. 
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• Prompt task creator for date 

• In the Method list, click Prompt task creator for date. 

7. Define the signature required task template security. 

1. In the left pane, click Security. 

2. In the right pane, under Users and Groups, click Add. 

3. In the Select Users and Groups dialog box, to add users or groups for privilege 
assignment, perform one of the following actions: 

• To add users, on the Users tab, perform one of the following actions: 

• In the Search results list, select one or more users, click Add, and then click OK. 

• In the Search for users box, type all or part of a first name, last name, or user name 
of the user you want and then click Search. In the Search results list, select one or 
more users, click Add, and then click OK. 

• To add groups, on the Groups tab, perform one of the following actions: 

• In the Search results list, select one or more groups, click Add, and then click OK. 

• In the Search for groups box, type all or part of the group name you want and then 
click Search. In the Search results list, select one or more groups, click Add, and 
then click OK. 

Note  To sort the Search results list in ascending or descending order, click the User 
Name, Last Name, First Name, or Group Name column headings. 

4. Under Users and Groups, select a user or group to which you want to assign privileges. 

5. To grant the user or group the following privileges, click the column in front of each privilege 
until    appears. You can grant or deny privileges to create, delete, modify, review, view, 
and manage returned tasks created with this template. Additionally, grant or deny the 
Manage privilege for the template itself. 

• Create - To allow the user or group to create tasks with this template, grant this 
privilege. 

• Delete - To allow the user or group to delete tasks created with this template, grant this 
privilege. 

• Manage - To allow the user or group to manage this template, grant this privilege. 

Note  In order for the user or group to access task templates in the Management 
Console, the user or group must have the Manage Task Templates privilege in the 
Global Privileges pane. 

• Modify - To allow the user or group to modify tasks created with this template, grant 
this privilege. 

• Review - To allow the user or group to review tasks created with this template, grant 
this privilege. Reviewers look at tasks after they are completed by a task assignee. 

Note  Modifying the Review privilege does not affect Signature Required Tasks. 

  



 

ImageNow Tasks Getting Started Guide Page 19 of 49 

• View - To allow the user or group to view tasks created with this template, grant this 
privilege. The user or group with this privilege can view tasks but cannot process or 
modify them. 
 
Note  The View privilege is not required for task assignees. The user or group assigned 
to a task automatically has the ability to view that task. Additionally, by default, task 
creators and reviewers are automatically able to view tasks they created or for which 
they are reviewers. However, because tasks are associated with documents and folders, 
the user or group must have the necessary document or folder privileges. 

• Manage Returned - To allow the user or group to view and modify returned tasks 
created with this template, grant this privilege. 

Note  Alternatively, you can click Allow All, Deny All, or Deselect All to allow, deny, or 
deselect all privileges for the selected user or group. 

6. Verify that the Automatically grant task creators the Review privilege for the tasks they 
create check box is selected. If you don’t want task creators to review the tasks they create, 
clear this option. 

5. Click OK. 

Note  The Incomplete Template dialog box appears if you did not add at least one user or group to 
the assignment list, if you did not select a return list, or if you selected the Send the folder to the 
workflow queue if the task location is a document in a folder check box, but did not select a 
queue in the Send to queue list. To save this template, click OK. The template is set to inactive. To 
return to the template to complete it, click Cancel. 

Create a document def ic iency task template 
To perform this procedure, you must be a user with management privileges, a manager, or the owner. 
For more information regarding task privileges, refer to the "Task privilege definitions" table. 

Create this task template type to indicate when a document is missing or is incomplete.  

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, on the Templates tab, in the Select a task type box, click Document deficiency. 

3. Under Templates, click New. 

4. In the Document Deficiency Task dialog box, perform the following substeps: 

1. Define the document deficiency task template properties. 

1. In the left pane, verify that Properties is selected. 

2. In the right pane, under General, in the Name box, type a name for your task template. 

3. In the Description box, type a template description. 

4. Under Options, verify that the Is active check box is selected. This makes the task template 
available to task creators assigning tasks from the Tasks toolbar. 

5. Optional. Select the Delete completed task check box to automatically and permanently 
delete a task and its related history after the task is completed.  
 
Note  If a task creator assigns a task series and the Delete completed task check box is 
selected, ImageNow does not delete the tasks in that series until the series is complete. 
After a series is complete, that entire series is removed. 
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2. Define the document deficiency task template components. 

1. In the left pane, click Components. 

2. In the right pane, under General, in the Task instructions box, type the instructions you 
want your task assignees to see. 

3. Optional. Select the Modifiable during task creation check box to allow a task creator to 
modify the instructions on the Options tab in the New Task dialog box. 

4. In the Task location section, select one or more of the following locations to determine 
where tasks created with this template can be assigned: 

• Folder – Create a task for a folder. 

• Document – Create a task for a document. 

• Page without a visual representation – Create a task for a page in a document with no 
visual representation. 

• Page with a visual representation – Create a task, along with a visual representation, 
for a page in a document.   

Notes   

• You must select at least one task location.  

• When multiple location options are selected, the task creator has the ability to select 
the location option he or she wants. 

5. In the Completion method box, select one of the following methods: 

• Manual – After task assignees complete a task, the task status is Complete. 

• Complete pending review – After task assignees complete a task, the task status is 
Complete Pending Review. Tasks with this status go to a reviewer. 

6. Optional. Under Workflow Assignment, select one or both of the following workflow 
options: 

• Send to queue -  Select the destination queue option you want. The default option is 
(None), in which case documents or folders are not sent to any queue. If you want to 
prompt the task creator for a workflow queue, select (Prompt). All other options are the 
queues to which the current user has the Add privilege.  

• Send the folder to the workflow queue if the task location is a document in a folder 
– If the task location is a document in a folder, select this option to send the folder to 
workflow. 

Note  To enable the Send the folder to the workflow queue if the task location is a 
document in a folder option, in the Send to queue box, select a queue or (Prompt). 

3. Optional. Define a document deficiency task template action. 

1. In the left pane, click Actions. 

2. In the right pane, under Scripting, perform one or more of the following actions to apply an 
iScript to: 

• Assigned tasks, in the Assigned list, select a script. 

• Returned tasks, in the Returned list, select a script. 
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• Pending review tasks, in the Pending review list, select a script. 

• Complete tasks, in the Complete list, select a script. 

• Canceled tasks, in the Canceled list, select a script. 

• Invalid tasks, in the Invalid list, select a script. 

3. Optional. To send an email notification to task assignees when a task is created with this 
template, under Notifications, select the Send email notification when task is created 
check box. 
 
Note  A task assignee must have an email address configured in his or her user profile in 
order to receive an email notification.  

4. Optional. To include a link in the email notification, perform one or both of the following 
actions: 

• To include an ImageNow link, select the Include ImageNow link check box. 

• To include a WebNow URL link, select the Include WebNow URL link check box. 

5. Click OK. 

4. Define the document deficiency task template assignment list. 

1. In the left pane, click Assignment. 

2. In the right pane, click Add. 

3. In the Select Users and Groups dialog box, to add users or groups so they are available for 
task assignment, select one of the following options: 

• To add users to your assignment list, on the Users tab, perform one of the following 
actions: 

• In the Search results list, select one or more users, click Add, and then click OK. 

• In the Search for users box, type all or part of a first name, last name, or user name 
of the user you want, and then click Search. In the Search results list, select one or 
more users, click Add, and then click OK. 

• To add groups to your assignment list, on the Groups tab, perform one of the following 
actions: 

• In the Search results list, select one or more groups, click Add, and then click OK. 

• In the Search for groups box, type all or part of the group name you want and then 
click Search. In the Search results list, select one or more groups, click Add, and 
then click OK. 

Notes 

• To sort the Search results list in ascending or descending order, click the User Name, 
Last Name, First Name, or Group Name column headings.  

• The Assignment list must contain at least one user or group. 

4. Optional. Select the Automatically assign the task to the task creator check box. 

5. Define the document deficiency template reasons lists. 

1. In the left pane, click Reasons. 
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2. Optional. Under Action Reasons, in the Action list, select the action list you want.  

3. Optional. To create a new reason list, click New and then perform the following steps: 

1. In the Reason List dialog box, on the General tab, in the Name box, type a reason list 
name. 

2. In the Description box, type a short description. 

3. Verify that the Is active check box is selected. 

4. On the List Members tab, under Available, select one or more reasons and then click 
Add. 

5. Optional. To create new reasons, click New and in the text box, type a reason. 

6. Click OK to close the Reason List dialog box. 

4. Optional. Select the Assignee must specify a reason during task completion check box to 
require task assignee to indicate why he or she is completing a task. 

5. Under Return Reasons, in the Return list, click a return list. 

Note  A return list is required. 

6. Define the document deficiency template due date method. 

1. In the left pane, click Due Date. 

2. In the right pane, under Due Date Calculation, in the Method list, select one of the following 
methods: 

• No due date 

• In the Method list, click No due date. 

• Based on assignment date 

1. In the Method list, click Based on assignment date. 

2. In the Days box, set the number of days you want. 

• Based on start date 

1. In the Method list, click Based on start date. 

2. In the Days box, set the number of days you want. 

• Prompt task creator for date 

• In the Method list, click Prompt task creator for date. 

7. Define the document deficiency template security. 

1. In the left pane, click Security. 

2. In the right pane, under Users and Groups, click Add. 

3. In the Select Users and Groups dialog box, to add users or groups for privilege 
assignment, perform one of the following actions: 

• To add users, on the Users tab, select one of the following options: 

• In the Search results list, select one or more users, click Add, and then click OK. 
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• In the Search for users box, type all or part of a first name, last name, or user name 
of the user you want and then click Search. In the Search results list, select one or 
more users, click Add, and then click OK. 

• To add groups, on the Groups tab, select one of the following options: 

• In the Search results list, select one or more groups, click Add, and then click OK. 

• In the Search for groups box, type all or part of the group name you want and then 
click Search. In the Search results list, select one or more groups, click Add, and 
then click OK. 

Note  To sort the Search results list in ascending or descending order, click the User 
Name, Last Name, First Name or Group Name column headings. 

4. Under Users and Groups, select a user or group to which you want to assign privileges. 

5. To grant the user or group the following privileges, click the column in front of each privilege 
until    appears. You can grant or deny privileges to create, delete, modify, review, view, 
and manage returned tasks created with this template. Additionally, grant or deny the 
manage privilege for the template itself. 

• Create - To allow the user or group to create tasks with this template, grant this 
privilege. 

• Delete - To allow the user or group to delete tasks created with this template, grant this 
privilege. 

• Manage - To allow the user or group to manage this template, grant this privilege. 

Note  In order for the user or group to access task templates in the Management 
Console, the user or group must have the Manage Task Templates privilege in the 
Global Privileges pane. 

• Modify - To allow the user or group to modify tasks created with this template, grant 
this privilege. 

• Review - To allow the user or group to review tasks created with this template, grant 
this privilege. Reviewers look at tasks after they have been completed by a task 
assignee. 

• View - To allow the user or group to view tasks created with the template, grant this 
privilege. The user or group with this privilege can view tasks but cannot process or 
modify them. 

Note  The View privilege is not required for task assignees. The user or group assigned 
to a task automatically has the ability to view that task. Additionally, by default, task 
creators and reviewers are automatically able to view tasks they created or for which 
they are reviewers. However, because tasks are associated with documents and folders, 
the user or group must have the necessary document or folder privileges. 

• Manage Returned - To allow the user or group to view and modify returned tasks 
created with this template, grant this privilege. 

Note  Alternatively, you can click Allow All, Deny All, or Deselect All to allow, deny, or 
deselect all privileges for the selected user or group. 
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6. Verify that the Automatically grant task creators the Review privilege for the tasks they 
create check box is selected. If you don’t want task creators to review the tasks they create, 
clear this option. 

5. Click OK. 

Note  The Incomplete Template dialog box appears if you did not add at least one user or group to the 
assignment list, if you did not select a return list, or if you selected the Send the folder to the workflow 
queue if the task location is a document in a folder check box, but did not select a queue in the Send 
to queue list. To save this template, click OK. The template is set to inactive. To return to the template 
to complete it, click Cancel. 

Create a pointer task template 
To perform this procedure, you must be a user with the management privileges, a manager, or the 
owner. For more information regarding task privileges, refer to the "Task privilege definitions" table. 

Create this task type to draw attention to a specific document or folder location for further action. 

1. In the Management Console, in the left pane, click Tasks. 

2. In the right pane, on the Templates tab, in the Select a task type box, click Pointer. 

3. Under Templates, click New. 

4. In the Pointer Task dialog box, perform the following steps: 

1. Define the pointer task template properties. 

1. In the left pane, verify that Properties is selected. 

2. In the right pane, under General, in the Name box, type a name for this task template. 

3. In the Description box, type a template description. 

4. Under Options, verify that the Is active check box is selected to make the task template 
available to task creators assigning tasks from the Tasks toolbar. 

5. Optional. Select the Delete completed task check box to automatically and permanently 
delete a task and its related history after the task is completed.   
 
Note  If a task creator assigns a task series and the Delete completed task check box is 
selected, ImageNow does not delete the tasks in that series until the series is complete. 
After a series is complete, that entire series is removed.  

2. Define the pointer task template components. 

1. In the left pane, click Components. 

2. In the right pane, under General, in the Task instructions box, type the instructions you 
want your task assignees to see. 

3. Optional. Select the Modifiable during task creation check box to allow a task creator to 
modify the instructions on the Options tab in the New Task dialog box. 

4. In the Task location section, select one or more of the following locations to determine 
where tasks created with this template can be assigned. 

• Folder – Create a task for a folder. 

• Document – Create a task for a document. 
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• Page without a visual representation – Create a task for a page in a document with no 
visual representation. 

• Page with a visual representation – Create a task, along with a visual representation, 
for a page in a document.   

Note  You must select at least one task location. 

5. In the Completion method box, select one of the following methods: 

• Manual – After task assignees complete a task, the task status is Complete. 

• Complete pending review – After task assignees complete a task, the task status is 
Complete Pending Review. Tasks with this status go to a reviewer. 

6. Optional. Under Workflow Assignment, select one or both of the following workflow 
options: 

• Send to queue -  Select the destination queue option you want. The default option is 
(None), in which case documents or folders are not sent to any queue. If you want to 
prompt the task creator for a workflow queue, select (Prompt). All other options are the 
queues to which the current user has the Add privilege.  

• Send the folder to the workflow queue if the task location is a document in a folder 
– If the task location is a document in a folder, select this option to send the folder to 
workflow. 

Note  To enable the Send the folder to the workflow queue if the task location is a 
document in a folder option, in the Send to queue box, select a queue or (Prompt). 

3. Optional. Define a pointer task template action. 

1. In the left pane, click Actions. 

2. In the right pane, under Scripting, perform one or more of the following actions to apply an 
iScript to: 

• Assigned tasks, in the Assigned list, select a script. 

• Returned tasks, in the Returned list, select a script. 

• Pending review tasks, in the Pending review list, select a script. 

• Complete tasks, in the Complete list, select a script. 

• Canceled tasks, in the Canceled list, select a script. 

• Invalid tasks, in the Invalid list, select a script. 

3. Optional. To send an email notification to task assignees when a task is created with this 
template, under Notifications, select the Send email notification when task is created 
check box. For more information, refer to the "Configure task email notifications" section. 
 
Note  A task assignee must have an email address configured in his or her user profile in 
order to receive an email notification.  

4. To include a link in the email notification, perform one or both of the following actions: 

• To include an ImageNow link, select the Include ImageNow link check box. 

• To include a WebNow URL link, select the Include WebNow URL link check box. 
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4. Define the pointer task template assignment list. 

1. In the left pane, click Assignment. 

2. In the right pane, click Add. 

3. In the Select Users and Groups dialog box, to add users or groups so they are available for 
task assignment, perform one of the following actions: 

• To add users to your assignment list, on the Users tab, perform one of the following 
actions: 

• In the Search results list, select one or more users, click Add, and then click OK. 

• In the Search for users box, type all or part of a first name, last name, or user name 
of the user you want and then click Search. In the Search results list, select one or 
more users, click Add, and then click OK. 

• To add groups to your assignment list, on the Groups tab, perform one of the following 
actions: 

• In the Search results list, select one or more groups and then click Add.  

• In the Search for groups box, type all or part of the group name you want and then 
click Search. In the Search results list, select one or more groups, click Add, and 
then click OK. 

Notes 

• To sort the Search results list in ascending or descending order, click the User Name, 
Last Name, First Name, or Groups column headings.  

• The assignment list must contain at least one user or group. 

4. Optional. Select the Automatically assign the task to the task creator check box. 

5. Define the pointer template reasons lists. 

1. In the left pane, click Reasons. 

2. Optional. Under Action Reasons, in the Action list, select the action list you want.   

3. Optional. Select the Assignee must specify a reason during task completion check box to 
require task assignees to select a reason after completing a task. 

4. Under Return Reasons, in the Return list, select a return list. 

Note  A return list is required. 

6. Define the pointer template due date method. 

1. In the left pane, click Due Date. 

2. In the right pane, under Due Date Calculation, in the Method list, select one of the following 
methods: 

• No due date 

• In the Method list, click No due date. 

• Based on assignment date 

1. In the Method list, click Based on assignment date. 

2. In the Days box, set the number of days you want. 
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• Based on start date 

1. In the Method list, click Based on start date. 

2. In the Days box, set the number of days you want. 

• Prompt task creator for date 

• In the Method list, click Prompt task creator for date.  

7. Define the pointer template security. 

1. In the left pane, click Security. 

2. In the right pane, under Users and Groups, click Add. 

3. In the Select Users and Groups and dialog box, to add users or groups for privilege 
assignment, perform one of the following actions: 

• To add users, on the Users tab, select one of the following options: 

• In the Search results list, select one or more users, click Add, and then click OK. 

• In the Search for users box, type all or part of a first name, last name, or user name 
of the user you want and then click Search. In the Search results list, select one or 
more users, click Add and then click OK. 

• To add groups, on the Groups tab, select one of the following options: 

• In the Search results list, select one or more groups, click Add, and then click OK. 

• In the Search for groups box, type all or part of the group name you want and then 
click Search. In the Search results list, select one or more groups, click Add, and 
then click OK. 

Note  To sort the Search results list in ascending or descending order, click the User 
Name, Last Name, First Name, or Group Name column headings. 

4. Under Users and Groups, select a user or group to which you want to assign privileges. 

5. To grant the user or group the following privileges, click the column in front of each privilege 
until    appears. You can grant or deny privileges to create, delete, modify, review, view, 
and manage returned tasks created with this template. Additionally, grant or deny the 
manage privilege for the template itself. 

• Create - To allow the user or group to create tasks with this template, grant this 
privilege. 

• Delete - To allow the user or group to delete tasks created with this template, grant this 
privilege. 

• Manage - To allow the user or group to manage this template, grant this privilege. 

Note  In order for the user or group to access task templates in the Management 
Console, the user or group must have the Manage Task Templates privilege in the 
Global Privileges pane. 

• Modify - To allow the user or group to modify tasks created with this template, grant 
this privilege. 
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• Review - To allow the user or group to review tasks created with this template, grant 
this privilege. Reviewers look at tasks after they have been completed by a task 
assignee. 

• View - To allow the user or group to view tasks created with this template, grant this 
privilege. The user or group with this privilege can view tasks but cannot process or 
modify them. 

Note  The View privilege is not required for task assignees.  The user or group assigned 
to a task automatically has the ability to view that task. Additionally, by default, task 
creators and reviewers are automatically able to view tasks they created or for which 
they are reviewers for. However, because tasks are associated with documents and 
folders, the user or group must have the necessary document or folder privileges. 

• Manage Returned - To allow the user or group to view and modify returned tasks 
created with this template, grant this privilege. 

Note  Alternatively, you can click Allow All, Deny All, or Deselect All to allow, deny or 
deselect all privileges for the selected user or group. 

6. Verify that the Automatically grant task creators the Review privilege for the tasks they 
create check box is selected. If you don’t want task creators to review the tasks they create, 
clear this option. 

5. Click OK. 

Conf igure task emai l  not i f icat ions 
To perform this procedure, you must be a user with management privileges, a manager, or the owner. In 
addition, you must have access to the ImageNow Server. 

You can configure a task template so that task assignees receive an email notification when a task is 
created using that template. All task templates use the same ImageNow and WebNow link settings. 

• To configure the options required for task creation email notifications, perform the following steps: 

1. Navigate to the ImageNow Server folder at [drive:]\inserver6\etc. 

2. Open the inserverNotification.ini file in a text editor, and in the [Email] section, perform the 
following substeps: 

1. Configure the smtp.server setting, as shown: 
 
smtp.server=<SMTP server name or IP address> 

2. Configure the smtp.server.port as shown. By default, the port number is 25. 
 
smtp.server.port=<Port number> 

3. Configure the smtp.from address, as shown: 
 
smtp.from=<From address for email notifications> 

3. Save and close the inserverNotification.ini file. 
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• Enter the user email addresses 

1. To add email addresses so that users can receive task creation notifications, perform the 
following substeps: 

1. In ImageNow Management Console, in the left pane, select Users. 

2. In the right pane, on the User Profiles tab, perform one of the following actions: 

• In the Select a user list, select the user for whom you want to add an email address and 
then click Modify. 

• In the Search for users box, type all or part of a first name, last name, or user name of 
the user you want and then click Search. In the Search results list, select the user for 
whom you want to add an email address and then click Modify. 

3. In the Modify User Profile dialog box, perform the following substeps: 

1. In the left pane, select Contact Information. 

2. In the right pane, in the Email box, type the user's email address. 

3. Click OK. 

2. Repeat the previous substeps to add email addresses for additional users. 

• Optional. Configure WebNow links 

• Navigate to the ImageNow Server at [drive:]\inserver6\etc and then perform the following 
substeps: 

1. Open the inow.ini file in a text editor and in the [WebNow] section, configure the 
webnow.url setting as shown: 
 
webnow.url=http://<host name>/webnow/ 

2. Save and close the inow.ini file. 

Crea te  tasks 
To create a task, you must first select a task template. After you select the template, you assign the task 
to users or to a group. Based on the configuration of the task template you select, you can also set the 
task location as well as the task start and due dates. Additionally, you can type instructions and 
comments for your task assignees, and you can select the workflow queue where you want to send a 
document or folder after you create and assign a task. You can use task levels to assign a series of 
tasks, and you can set up a task series as a hierarchy to accelerate the task completion process. To 
review these features, refer to the “Task levels and series hierarchies” section in the introduction. 

Select  a s ignature required task template 
In ImageNow and WebNow, when you want users or a group member to digitally sign a document, 
create and assign a signing task. To perform this procedure, you must be a user with the Create 
privilege for a task template, a manager, or the owner. For more information regarding the Create 
privilege, refer to the “Grant task creator privileges” topic. 

The New Task dialog box contains two tabs: Assignment and Options. When you create a task, the 
configuration of the task template determines the options available on these tabs. 
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1. Open a document or folder. 

1. Verify that the Tasks toolbar is open. 

• How? 

• To display the Tasks toolbar, in ImageNow Viewer, on the View menu, point to 
Toolbars and then click Tasks. 

2. On the Tasks toolbar, right-click the New signing task    button and then click the signing 
task template you want. When you select a template, a Tooltip displays the template description. 

3. In the New Task dialog box, on the Assignment tab, assign the task to a user or group, as 
described in the following procedures. 

Assign a s ignature required task to a user 
1. Click Add Users. 

2. In the Select Users dialog box, perform one of the following options: 

• In the Search results list, select one or more users and then click Add.  

• In the Search for users box, type all or part of a user name, first name, or last name, and then 
click Search. In the Search results list, select one or more users and then click Add. 

Note  To sort the Search results and Selected users lists in ascending or descending order, 
click the User Name, Last Name, or First Name column headers. 

3. In the Selected users list, verify that the users you want to assign the task to appear and then click 
OK. 

4. Optional. To assign additional task levels, on the Assignment tab, click the PLUS SIGN (+) and then 
repeat the previous steps. 

Note  To add an additional level, clear the individual task check box if it is selected. When you add 
an additional level, ImageNow creates a single task for all task assignees on that level. 

1. Optional. To create a task that is created and assigned to each user or group member, 
select the Create an individual task for each user or group member check box. When you 
do not select this option, a single task is created and assigned to all users. 

Note  When you create a task for the All Users group, this option is ignored and only a single 
task is created. 

2. Optional. To create a task series based on a hierarchy, perform the following substeps: 

3. Select the Set series as a hierarchy check box. When you set the task series to a hierarchy, 
a single task is created for all task assignees on that level.  

4. To assign the first level in the hierarchy, click Add Users. 

5. In the Search results list, select one or more users and then click Add. 

6. In the Selected users list, verify that the users you want to assign the task to appear and 
then click OK. 

7. To assign the second level in the hierarchy, click the PLUS SIGN (+) and then click Add 
Users to assign users to this level. As you add levels, the tab name displays as Level <x>, 
where <x> is a placeholder for the level number. 

Note  A task series hierarchy must contain at least two levels. 
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8. Repeat the previous substep to create additional levels. You can create a maximum of ten 
levels. 

Notes 

• If only a single user is on the task template Assignment List, that user appears on the 
Level 1 tab by default. 

• When the Automatically assign the task to the task creator check box is selected for 
the task template, the task creator’s name displays on the Level 1 tab, along with all 
additional tabs, by default. 

• In the Select Users dialog box, to view the names of users you recently selected, in the 
Search for Users box, type a name. The list of users changes as you type. By default, 
the Search for Users list stores a maximum of 50 users.  

• The Search results list is limited to the users and group members on the Assignment 
List in a task template. 

• Group members appear in the Search results list on the Users tab to allow you to 
assign a task to members of a group. To assign a task to the entire group, click Add 
Group. 

5. In the Details section, under Location, select one the following locations: 

• Document - Create a task for a document. 

• Page with a visual representation - Create a task, along with a visual representation, for a page 
in a document. 

Notes 

• When an image is a non-raster image, such as a Word document, then Document is the 
only available Location option. 

• The Folder and Page without a visual representation locations are unavailable and appear 
dimmed when you create a signing task. 

6. In the Start date box, set the start date for the task. 

7. In the Due date box, set the due date. 

8. On the Options tab, perform the following substeps: 

• Optional. Under General, select the Expedite this task check box. This presents the task to the 
assignee first when starting automatic task processing. 

• Optional. In the Instructions box, type the instructions you want task assignees to see. 

• Optional. In the Comments box, type your comments as they relate to this task. Comments 
appear in the Comments box of a task and are not modifiable. 

• Optional. Under Workflow, in the Send to queue list, click the queue where you want to send 
documents or folders after tasks are assigned to the associated documents or folders. The 
queues available in the Sent to queue list are those queues for which you have the Add 
privilege.  

• Optional. Select the Send folder instead of document check box to send folders to a workflow 
queue after you assign a task to a document in the associated folders. 

9. Click OK. 
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10. Optional. In the confirmation dialog box, click OK and then drag the visual representation to the 
location you want on the document. The dialog box appears when you click Page with a visual 
representation under Location. 

Assign a s ignature required task to a group 
1. Click Add Group.  

2. To select a group, perform one of the following actions: 

• In the Search for group box, type the name of the group to which you want to assign a task. In 
the Search results list, select the group and then click OK. 

• In the Select Group dialog box, in the Search results list, select the group you want to assign a 
task to and then click OK. 

3. Optional. To assign additional task levels, on the Assignment tab, click the Add Level (+) tab and 
then repeat the previous steps. 

Note  To add an additional level, clear the individual task check box if it is selected. When you add 
an additional level, ImageNow creates a single task for all task assignees on that level. 

4. Optional. To create a task that is created and assigned to each user or group member, select the 
Create an individual task for each user or group member check box. When you do not select this 
option, a single task is created and assigned to all users. 

Note  When you create a task for the All Users group, this option is ignored and only a single task is 
created. 

Notes   

• To sort the Search results list in ascending or descending order, click the Groups column 
header. 

• The Search results list is limited to groups on the Assignment List in a task template. 

• You cannot assign multiple groups to a task. 

• To assign a task to members of a group but not to the entire group, click Add Users. User 
names for the members of a group appear in the Search results list on the Users tab. 

5. In the Details section, under Location, select one the following locations: 

• Document - Create a task for a document. 

• Page with a visual representation - Create a task, along with a visual representation, for a page 
in a document. 

Notes 

• When an image is a non-raster image, such as a Word document, then Document is the 
only available Location option. 

• The Folder and Page without a visual representation locations are unavailable and appear 
dimmed when you create a signing task. 

6. In the Start date box, set the start date for the task. 

7. In the Due date box, set the due date. 
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8. On the Options tab, perform the following substeps: 

1. Optional. Under General, select the Expedite this task check box. This presents the task to the 
assignee first when starting automatic task processing. 

2. Optional. In the Instructions box, type the instructions you want task assignees to see. 

3. Optional. In the Comments box, type your comments as they relate to this task. Comments 
appear in the History box of a task and are not modifiable. 

4. Optional. Under Workflow, in the Send to queue list, click the queue where you want to send 
documents or folders after tasks are assigned to the associated documents or folders. The 
queues available in the Sent to queue list are those queues for which you have the Add 
privilege.  

5. Optional. Select the Send folder instead of document check box to send folders to a workflow 
queue after you assign a task to a document in the associated folders. 

9. Click OK. 

10. Optional. In the confirmation dialog box, click OK and then drag the visual representation to the 
location you want on the document. The dialog box appears when you click Page with a visual 
representation under Location. 

Create a document def ic iency task 
In ImageNow and WebNow, when a document is missing or is incomplete, you can assign a document 
deficiency task.  To perform this procedure, you must be a user with the Create privilege for a task 
template, a manager, or the owner.  For more information regarding the Create privilege, refer to the 
“Grant task creator privileges” topic. 

The New Task dialog box contains two tabs: Assignment and Options. When you create a task, the 
configuration of the task template determines the options available on these tabs. 

1. Open a document or folder. 

2. Verify that the Tasks toolbar is open. 

• How? 

• To display the Tasks toolbar, in ImageNow Viewer, on the View menu, point to Toolbars 
and then click Tasks. 

3. On the Tasks toolbar, right-click the New document deficiency task    button and click the 
document deficiency task template you want. When you select a template, a Tooltip displays the 
template description. 

4. In the New Task dialog box, on the Assignment tab, assign the task to a user or group, as 
described in the following procedures. 

Assign a document def ic iency task to a user 
1. Click Add Users. 

2. In the Select Users dialog box, perform one of the following options: 

• In the Search results list, select one or more users and then click Add.  

  



 

ImageNow Tasks Getting Started Guide Page 34 of 49 

• In the Search for users box, type all or part of a user name, first name, or last name, and then 
click Search. In the Search results list, select one or more users and then click Add. 

Note  To sort the Search results and Selected users lists in ascending or descending order, 
click the User Name, Last Name, or First Name column headers. 

3. In the Selected users list, verify that the users you want to assign the task to appear and then click 
OK. 

4. Optional. To assign additional task levels, on the Assignment tab, click the PLUS SIGN (+) and then 
repeat the previous substeps. 

Note  To add an additional level, clear the individual task check box if it is selected. When you add 
an additional level, ImageNow creates a single task for all task assignees on that level. 

5. Optional. To create a task that is created and assigned to each user or group member, select the 
Create an individual task for each user or group member check box. When you do not select this 
option, a single task is created and assigned to all users. 

Note  When you create a task for the All Users group, this option is ignored and only a single task is 
created. 

6. Optional. To create a task series based on a hierarchy, perform the following substeps: 

• Select the Set series as a hierarchy check box. When you set the task series to a hierarchy, a 
single task is created for all task assignees on that level.  

• To assign the first level in the hierarchy, click Add Users. 

• In the Search results list, select one or more users and then click Add. 

• In the Selected users list, verify that the users you want to assign the task to appear and then 
click OK. 

• To assign the second level in the hierarchy, click the PLUS SIGN (+) and then click Add Users 
to assign users to this level. As you add levels, the tab name displays as Level <x>, where <x> is 
a placeholder for the level number. 
Note  A task series hierarchy must contain at least two levels. 

• Repeat the previous substep to create additional levels. You can create a maximum of ten 
levels. 

Notes 

• If only a single user is on the task template Assignment List, that user appears on the Level 
1 tab by default. 

• When the Automatically assign the task to the task creator check box is selected for the 
task template, the task creator’s name displays on the Level 1 tab, along with all additional 
tabs, by default. 

• In the Select Users dialog box, to view the names of users you recently selected, in the 
Search for Users box, type a name. The list of users changes as you type. By default, the 
Search for Users list stores a maximum of 50 users.  

• The Search results list is limited to the users and group members on the Assignment List in 
a task template. 

• Group members appear in the Search results list on the Users tab to allow you to assign a 
task to members of a group. To assign a task to the entire group, click Add Group. 
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7. In the Details section, under Location, select one the following locations: 

• Folder - Create a task for a folder. 

• Document - Create a task for a document. 

• Page without a visual representation - Create a task for a page in a document with no visual 
representation. 

• Page with a visual representation - Create a task, along with a visual representation, for a page 
in a document. 

Note  The options selected in the task template and your current location determine what location 
options are available. 

8. In the Start date box, set the start date for the task. 

9. In the Due date box, set the due date. 

10. On the Options tab, perform the following substeps: 

• Optional. Under General, select the Expedite this task check box to present the task to the 
assignee first when starting automatic task processing. 

• Optional. In the Instructions box, type the instructions you want task assignees to see. 

• Optional. In the Comments box, type your comments as they relate to this task. Comments 
appear in the History box of a task and are not modifiable. 

• Optional. Under Workflow, in the Send to queue box, click the queue where you want to send 
documents or folders after tasks are assigned to the associated documents or folders. 

• Optional. Select the Send folder instead of document check box to send folders to a workflow 
queue after you assign a task to a document in the associated folders. 

11. Click OK. 

12. Optional. In the confirmation dialog box, click OK and then drag the visual representation to the 
location you want on the document. The dialog box appears when you click Page with a visual 
representation under Location. 

Assign a document def ic iency task to a group 
1. Click Add Group.  

2. To select a group, perform one of the following actions: 

• In the Search for group box, type the name of the group to which you want to assign a task. In 
the Search results list, select the group and then click OK. 

• In the Select Group dialog box, in the Search results list, select the group you want to assign a 
task to and then click OK. 

3. Optional. To assign additional task levels, on the Assignment tab, click the Add Level (+) tab and 
then repeat the previous steps. 

Note  To add an additional level, clear the individual task check box if it is selected. When you add 
an additional level, ImageNow creates a single task for all task assignees on that level. 
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4. Optional. To create a task that is created and assigned to each user or group member, select the 
Create an individual task for each user or group member check box. When you do not select this 
option, a single task is created and assigned to all users. 

Note  When you create a task for the All Users group, ImageNow ignores this option and creates 
only a single task. 

Notes   

• To sort the Search results list in ascending or descending order, click the Groups column 
header. 

• The Search results list is limited to groups on the Assignment List in a task template. 

• You cannot assign multiple groups to a task. 

• To assign a task to members of a group but not to the entire group, click Add Users. User 
names for the members of a group appear in the Search results list on the Users tab. 

5. In the Details section, under Location, select one the following locations: 

• Folder - Create a task for a folder. 

• Document - Create a task for a document. 

• Page without a visual representation - Create a task for a page in a document with no visual 
representation. 

• Page with a visual representation - Create a task, along with a visual representation, for a page 
in a document.   

Note  The options selected in the task template and your current location determine what 
location options are available. 

6. In the Start date box, set the start date for the task. 

7. In the Due date box, set the due date. 

8. On the Options tab, perform the following substeps: 

1. Optional. Under General, select the Expedite this task check box to present the task to the 
assignee first when starting automatic task processing. 

2. Optional. In the Instructions box, type the instructions you want task assignees to see. 

3. Optional. In the Comments box, type your comments as they relate to this task. Comments 
appear in the History box of a task and are not modifiable. 

4. Optional. Under Workflow, in the Send to queue list, click the queue where you want to send 
documents or folders after tasks are assigned to the associated documents or folders. The 
queues available in the Sent to queue list are those queues for which you have the Add 
privilege.  

5. Optional. Select the Send folder instead of document check box to send folders to a workflow 
queue after you assign a task to a document in the associated folders. 

9. Click OK. 

10. Optional. In the confirmation dialog box, click OK and then drag the visual representation to the 
location you want on the document. The dialog box appears when you click Page with a visual 
representation under Location. 
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Create a pointer task 
You can create a pointer task when a user or group needs to take further action on a document or folder 
in ImageNow and WebNow. To perform this procedure, you must be a user with the Create privilege for 
a task template, a manager, or the owner. For more information regarding the Create privilege, refer to 
the “Grant task creator privileges” topic. 

The New Task dialog box contains two tabs: Assignment and Options. When you create a task, the 
configuration of the task template determines the options available on these tabs. 

1. Open a document or folder. 

2. Verify that the Tasks toolbar is open. 

• How? 

• To display the Tasks toolbar, in ImageNow Viewer, on the View menu, point to Toolbars 
and then click Tasks. 

3. On the Tasks toolbar, right-click the New pointer task    button and then click a pointer task 
template. When you select a template, a Tooltip displays the template description. 

4. In the New Task dialog box, on the Assignment tab, assign the task to a user or group, as 
described in the following procedures. 

Assign a pointer task to a user 
1. Click Add Users. 

2. In the Select Users dialog box, perform one of the following options: 

• In the Search results list, select one or more users and then click Add.  

• In the Search for users box, type all or part of a user name, first name, or last name, and then 
click Search. In the Search results list, select one or more users and then click Add. 

Note  To sort the Search results and Selected users lists in ascending or descending order, click the 
User Name, Last Name, or First Name column headers. 

3. In the Selected users list, verify that the users you want to assign the task to appear and then click 
OK. 

4. Optional. To assign additional task levels, on the Assignment tab, click the PLUS SIGN (+) and then 
repeat the previous substeps. 

Note  To add an additional level, clear the individual task check box if it is selected. When you add 
an additional level, ImageNow creates a single task for all task assignees on that level. 

5. Optional. To create a task that is created and assigned to each user or group member, select the 
Create an individual task for each user or group member check box. When you do not select this 
option, a single task is created and assigned to all users. 

Note  When you create a task for the All Users group, ImageNow ignores this option and creates 
only a single task. 

6. Optional. To create a task series based on a hierarchy, perform the following substeps: 

1. Select the Set series as a hierarchy check box. When you set the task series to a hierarchy, a 
single task is created for all task assignees on that level.  

2. To assign the first level in the hierarchy, click Add Users. 
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3. In the Search results list, select one or more users and then click Add. 

4. In the Selected users list, verify that the users you want to assign the task to appear and then 
click OK. 

5. To assign the second level in the hierarchy, click the PLUS SIGN (+) and then click Add Users 
to assign users to this level. As you add levels, the tab name displays as Level <x>, where <x> is 
a placeholder for the level number. 

Note  A task series hierarchy must contain at least two levels. 

6. Repeat the previous substep to create additional levels. You can create a maximum of ten 
levels. 

Notes 

• If only a single user is on the task template Assignment List, that user displays on the Level 
1 tab by default. 

• When the Automatically assign the task to the task creator check box is selected for the 
task template, the task creator’s name displays on the Level 1 tab, and all additional tabs, 
by default. 

• In the Select Users dialog box, to view the names of users you recently selected, in the 
Search for Users box, type a name. The list of users filters as you type. By default, the 
Search for Users list stores a maximum of 50 users.  

• The Search results list is limited to the users and group members on the Assignment List in 
a task template. 

• Group members appear in the Search results list on the Users tab to allow you to assign a 
task to members of a group. To assign a task to the entire group, click Add Group. 

7. In the Details section, under Location, select one the following locations: 

• Folder - Create a task for a folder. 

• Document - Create a task for a document. 

• Page without a visual representation - Create a task for a page in a document with no visual 
representation. 

• Page with a visual representation - Create a task, along with a visual representation, for a 
page in a document. 

Note  The options selected in the task template and your current location determine what location 
options are available. 

8. In the Start date box, set the start date for the task. 

9. In the Due date box, set the due date. 

10. On the Options tab, perform the following substeps: 

1. Optional. Under General, select the Expedite this task check box to present the task to the 
assignee first when starting automatic task processing. 

2. Optional. In the Instructions box, type the instructions you want task assignees to see. 

3. Optional. In the Comments box, type your comments as they relate to this task. Comments 
appear in the History box of a task and are not modifiable. 
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4. Optional. Under Workflow, in the Send to queue box, click the queue where you want to send 
documents or folders after tasks are assigned to the associated documents or folders. 

5. Optional. Select the Send folder instead of document check box to send folders to a workflow 
queue after you assign a task to a document in the associated folders. 

11. Click OK. 

12. In the confirmation dialog box, click OK and then drag the visual representation to the location you 
want on the document. The dialog box appears when you click Page with a visual representation 
under Location. 

Assign a pointer task to a group 
1. Click Add Group.  

2. To select a group, perform one of the following actions: 

• In the Search for group box, type the name of the group to which you want to assign a task. In 
the Search results list, select the group and then click OK. 

• In the Select Group dialog box, in the Search results list, select the group you want to assign a 
task to and then click OK. 

3. Optional. To assign additional task levels, on the Assignment tab, click the Add Level (+) tab and 
then repeat the previous substeps. 

Note  To add an additional level, clear the individual task check box if it is selected. When you add 
an additional level, ImageNow creates a single task for all task assignees on that level. 

4. Optional. To create a task that is created and assigned to each user or group member, select the 
Create an individual task for each user or group member check box. When you do not select this 
option, a single task is created and assigned to all users. 

Note  When you create a task for the All Users group, this option is ignored and only a single task is 
created. 

Notes   

• To sort the Search results list in ascending or descending order, click the Groups column 
header. 

• The Search results list is limited to groups on the Assignment List in a task template. 

• You cannot assign multiple groups to a task. 

• To assign a task to members of a group and not the entire group, click Add Users. User names 
for the members of a group appear in the Search results list on the Users tab. 

5. In the Details section, under Location, click one of the following locations: 

• Folder - Create a task for a folder. 

• Document - Create a task for a document. 

• Page without a visual representation - Create a task for a page in a document with no visual 
representation. 
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• Page with a visual representation - Create a task, along with a visual representation, for a 
page in a document. 

Note  The options selected in the task template and your current location determine what location 
options are available. 

6. In the Start date box, set the start date for the task. 

7. In the Due date box, set the due date. 

8. On the Options tab, perform the following substeps: 

1. Optional. Under General, select the Expedite this task check box to present the task to the 
assignee first when starting automatic task processing. 

2. Optional. In the Instructions box, type the instructions you want task assignees to see. 

3. Optional. In the Comments box, type your comments as they relate to this task. Comments 
appear in the History box of a task and are not modifiable. 

4. Optional. Under Workflow, in the Send to queue box, click the queue where you want to send 
documents or folders after tasks are assigned to the associated documents or folders. 

5. Optional. Select the Send folder instead of document check box to send folders to a workflow 
queue after you assign a task to a document in the associated folders. 

9. Click OK. 

10. In the confirmation dialog box, click OK and then drag the visual representation to the location you 
want on the document. The dialog box appears when you click Page with a visual representation 
under Location. 

Process  tasks 
After you create tasks, assignees can select the My Assigned view to access their assigned tasks.  In 
this view, a task assignee can open and then digitally sign a document or complete a document 
deficiency or pointer task. In addition to completing or signing tasks, task assignees can also skip or 
return them. 

My Assigned v iew task opt ions 
When you work with tasks in the My Assigned view, you set the startup and processing options.  The 
startup action options determine what task opens when you select the My Assigned view from the Tasks 
button on the ImageNow toolbar. 

1. On the ImageNow toolbar, click the Settings menu and then click Options. 

2. In the ImageNow Options dialog box, in the left pane, click Tasks. 

3. In the right pane, under Task Startup, in the Start action list, select one of the following options to 
specify which tasks appear when you launch the My Assigned view: 

• To display a list of all tasks that have been assigned to you, select Show list. 

• To open a task that is next due, select Get next task due. 

• To open a selected type of task that is next due, select Get next task due of selected type and 
then in the Task type list, select a task type. 
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• To open the oldest task, select Get oldest task. 

• To open a selected type of task that is the oldest task, select Get oldest task of selected type 
and then, in the Task type list, select a task type you want. 

4. To set the next action processing options in the My Assigned view, under Task Processing, 
perform one or more of the following actions: 

• Select the Automatically launch next task upon task completion check box to automatically 
open a task or clear the check box to turn off the automatic launch. When you select this option, 
in the Next action list, select one of the following options: 

• To open a task that is next due, select Get next task due. 

• To open a selected type of task that is next due, select Get next task due of selected type 
and then, in the Task type list, select a task type. 

• If you set the Start action box to Show list, to open a task from the top of the task list, 
select Get next task from top of task list.  

• If you set the Start action box to Show list, to open the next task in the task list, select Get 
next task in task list. 

• To open the oldest task, select Get oldest task. 

• To open a selected type of task that is the oldest, select Get oldest task of selected type 
and then, in the Task type list, select a task type. 

• Select the Process all the tasks for the current folder or document check box if you want to 
process all the tasks associated with a folder or document before moving on to the next folder 
or document where a task is assigned. Clear the check box to move to the next task in the task 
list without first completing all the tasks associated with the current folder or document. 

• To revisit tasks you skip after all other tasks are complete, under Skipped Tasks, select the 
Revisit skipped tasks after all other tasks have been completed check box. 

5. Click OK. 

Open a task 
Select the My Assigned view in ImageNow and WebNow to access the tasks that have been assigned to 
you. To access this view, you must be a user with the Access privilege. For more information, refer to the 
“Verify task assignee view privileges” topic. 

1. On the ImageNow toolbar, click the Tasks down arrow and then click My Assigned. This view 
automatically returns a list of tasks that have been assigned to you. 

2. In ImageNow Explorer, double-click a task to open it. 

Sign a task 
To digitally sign documents in ImageNow and WebNow, you must be a user with the Documents Sign 
and the Document Management Use Library Services privileges. For more information, refer to the “Task 
privilege definitions” table in the reference topic of this document. 

1. In the viewer, in the Tasks pane, in the Reason list, select a signing reason to indicate why you are 
signing a document. 

2. In the Tasks pane, click Sign. 
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3. If you have a Digital ID, go to step 4. Otherwise perform the following substeps: 

1. In the Digital Signature Authentication dialog box, under Digital Signature Password, perform 
the following steps: 

1. In the Password box, type a Digital ID password. 

2. In the Confirm password box, retype the password. 

3. Optional. In the Password hint box, type a hint to help you remember your Digital ID 
password. 

2. Optional. Under Name Confirmation, perform the following substeps: 

1. Optional. In the Prefix box, type or select a prefix for your Digital ID. 

2. In the First name box, type your first name. 

3. In the Last name box, type your last name. 

4. Optional. In the Suffix box, type or select a suffix for your Digital ID. 

3. Click OK. 

4. In the Digital Signature Authentication dialog box, in the Password box, type your password and 
then click OK.  

Note  Depending on the option selected in the Prompt user to enter signing password box in the 
Digital Signatures area of Management Console, you either enter your password for each document 
you sign, or enter your password based on the frequency determined by the administrator.  

Complete a task 
Whether you are working in ImageNow or WebNow, you can complete the document deficiency and 
pointer tasks that have been assigned to you. 

1. In the viewer, in the Tasks pane, in the Reason list, select an action reason. 

Note  In the Reason list, None appears if an action reason is marked as not required in the task 
template. 

2. In the Tasks pane, click Complete. 

Note  A Complete button is available for pointer and document deficiency tasks. A Sign button is 
available for signature required tasks. 

Return a task 
When you work with tasks in ImageNow and WebNow, you can return a task to the task creator. Before 
you return a task, you must select a return reason.  

1. In the viewer, in the Tasks pane, click Return to return the task to the task creator. 

2. In the Return Task dialog box, perform the following substeps: 

1. In the Reason list, select the reason you are returning the task. 

Note  A return reason is required for all task types. 

2. Optional. In the Comments box, type any comments you want the task creator to see. 

3. Click OK. 
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Skip a task 
As you process tasks in ImageNow and WebNow, you can skip tasks so that you can work them at a 
later time. 

• In the viewer, in the Tasks pane, to process a task at a later time, click Skip. The options you have 
set for task processing determine what tasks, if any, appear automatically. For more information, 
refer to the “My Assigned view task options” section.  

Process  Complete  Pend ing  Rev iew tasks 
After a task assignee completes a task, a task reviewer may be required to review the task. A review is 
required when the completion method is set to "Complete pending review" in the task template. You 
assign users or groups the Review privilege in the Security area of the task template. For more 
information, refer to the “Grant task reviewer privileges” topic.  

View and process complete pending rev iew tasks 
In ImageNow and WebNow, you can access the To Review view to get to the tasks you need to review. 

1. On the ImageNow toolbar, click the Tasks down arrow and then click To Review.  The view 
automatically returns a list of tasks that require your review. 

2. In ImageNow Explorer, double-click a task to open it.  

3. In the Tasks pane, click Complete. The task status changes from Complete Pending Review to 
Complete. 



 

ImageNow Tasks Getting Started Guide Page 44 of 49 

Reference 
Task toolbars 

Task toolbar  

Tool Name Description 

 New Signing Task Create a new signing task. 

 New Pointer Task Create a new pointer task. 

 New Document 
Deficiency Task 

Create a new document deficiency task. 

 

Task pane toolbar  

Tool Name Description 

 Open Display the selected task. 

 Modify Display the Modify Task dialog box, in which you can change 
the selected task. 

 Reassign Assign the selected task to a different user or group. 

 Properties Display the Task Properties dialog box for the selected task. 

 Delete Delete the selected task. 

 Refresh Refresh the task grid in the Tasks pane view. 
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Task pr iv i leges def in i t ions 
Privileges are assigned to users or groups by a user with management privileges, a manager, or the 
owner. In ImageNow, you assign privileges to control the actions users can perform. Privileges are 
assigned at the user or group level. 

The following table lists all of the task privileges by type: View Access privileges, Manage privileges, and 
Task Template privileges, and Drawer and Document Type privileges. The table also lists the privilege 
definition, dependency information, and the privilege location. This table also lists the privilege definition, 
dependency information, and the privilege location. 

Type Definition Dependency Location 

Manage Privileges 

Task Templates The user can rename, copy, 
modify, or delete the task 
templates where he or she is 
the task template creator. The 
user can create new task 
templates in the Management 
Console. To manage another 
user's template, refer to the 
Manage privilege below. 

This privilege has no 
dependencies. 

This privilege is located on 
the Users or Groups pane, 
on the Security tab, in the 
Security Settings dialog 
box, in the Global 
Privileges pane. 

Task Views The user can access the Task 
tab in the Views area, in 
Management Console. To 
manage a view, the user must 
have the Manage privilege for 
that view. 

This privilege has no 
dependencies. 

This privilege is located on 
the Users or Groups pane, 
on the Security tab, in the 
Security Settings dialog 
box, in the Global 
Privileges pane. 

Digital Signatures The user can access the Digital 
Signatures area of 
Management Console and can 
manage Action reasons and 
reason lists. You must assign 
Action reasons for Signature 
required task templates. It is 
important to note that a user 
with this privilege can set 
Digital ID Expiration, Signing 
Password and Digital 
Signature Report options for 
your ImageNow system. 

This privilege has no 
dependencies. 

This privilege is located on 
the Users or Groups pane, 
on the Security tab, in the 

Security Settings dialog 
box, in the Global 
Privileges pane. 
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Type Definition Dependency Location 

Task Template 

Create The user can create new tasks 
with this template. The user 
can also modify, reassign, add 
comments to, return and 
cancel tasks he or she created 
with this template. 

For a user to create 
tasks for a document, he 
or she must be able to 
open the document. On 
the Drawer Privileges 
tab, with the appropriate 
drawer selected, grant 
the Search and Open 
privileges in the Content 
privileges list. 

 

To use document type 
privileges to access 
documents, on the 
Drawer Privileges tab, 
with the appropriate 
drawer selected, grant 
the Search privilege in 
the Content privileges 
list. On the Document 
Type Privileges tab, with 
the appropriate 
document type selected, 
grant the Open privilege 
in the Documents 
privileges list. 

 

For a user to create 
tasks for a folder, he or 
she must be able to open 
the folder. On the Folder 
Type Privileges tab, 
under the Folder Type 
list, grant the Use 
privilege. On the Drawer 
Privileges tab, with the 
Folders drawer selected, 
grant the Search and 
Open privileges in the 
Content privileges list. 

This privilege is located in 
the Security area of a task 
template. 

Delete The user can delete tasks 
created with this template. 

 

This privilege has no 
dependencies. 

This privilege is located in 
the Security area of a task 
template. 

Modify The user can modify, cancel, 
reassign, add comments to, or 
return tasks created with this 
template. 

This privilege has no 
dependencies. 

This privilege is located in 
the Security area of a task 
template. 
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Type Definition Dependency Location 

Review The user can review any task 
created with this task template. 

For your tasks to go to a 
reviewer, in the 
Components area of this 
task template, the 
Completion method must 
be set to Complete 
pending review. 

This privilege is located in 
the Security area of a task 
template. 

View The user can view tasks 
created with this template. A 
user with this privilege, much 
like an auditor, can view a task, 
but cannot make any changes 
to the task itself. Grant this 
privilege to a user who has no 
other task privileges. 

This privilege has no 
dependencies. 

This privilege is located in 
the Security area of a task 
template. 

Manage Grant this privilege to a user to 
allow him or her to manage 
this task template. The user 
can rename, copy, modify or 
delete this task template.  

You must grant the user 
the Task Templates 
privilege.  

This privilege is located in 
the Security area of a task 
template. 

Manage Returned The user, in addition to the 
task creator, can view and 
modify returned tasks created 
with this template. Granting 
this privilege also allows the 
user to manage returned tasks 
for tasks created using an 
iScript. 

This privilege has no 
dependencies. 

This privilege is located in 
the Security area of a task 
template. 

Drawer and Document Type 

Sign The user can digitally sign a 
document. A user must have 
this privilege to sign a 

signature required task type. 

This privilege has no 
dependencies. 

This privilege is located on 
the Users or Groups pane, 
on the Security tab, in the 
Security Settings dialog 
box, in the Drawer 
Privileges and Document 
Type Privileges panes. 

Use Version Control The user can use version 
control. A user must have this 
privilege to sign a signature 
required task type. 

This privilege has no 
dependencies. 

This privilege is located on 
the Users or Groups pane, 
on the Security tab, in the 
Security Settings dialog 
box, in the Drawer 
Privileges and Document 
Type Privileges panes. 
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